
1997 Grolier Multimedia Encyclopedia™ Version 9.00 
Readme File for Windows 3.1, 3.11 and Windows 95

If this file and the help file (reached via the Help menu in The 1997 Grolier Multimedia 
Encyclopedia) fail to resolve any problems you are having, you can contact our technical 
support team at:

800-356-5590 (voice - toll free)
203-796-2536 (voice- toll)
203-797-6872 (BBS - see below for more info.)
203-797-3835 (FAX)

Via the Internet:
Grolier Home Page: http://www.grolier.com
email: techsup@grolier.com

By Mail:
Grolier Interactive
Attn: Technical Support
Sherman Turnpike
Danbury, CT 06816

This file contains the following sections:

System Requirements
Installation
Troubleshooting and Important Notes
The Grolier BBS
Grolier on the Internet
Video Card Manufacturers

System Requirements

To use the 1997 Grolier Multimedia Encyclopedia™, you need:

A multimedia PC or compatible with a 486 DX/33 MHz or higher microprocessor; 8 
MB of RAM , "double-speed" CD-ROM drive (300 KB/sec or higher transfer rate); 
sound card, and SVGA 256-color monitor.

Hard-disk space: 10 MB for Windows 95, or 10 MB for Windows 3.1 (Minimal 
Installation)

Windows 95 operating system, or MS-DOS operating system version 5.0 or later with
Microsoft Windows 3.1 or later



For Windows 3.1 only, Microsoft CD Extensions version 2.2 or later. Microsoft 
Extensions normally are supplied with your CD-ROM device drivers, so if you have a
working CD-ROM drive you probably meet this requirement.

Apple QuickTime for Windows version 2.1.1 or later (supplied with product)

Microsoft Mouse or compatible pointing device

Wave-table sound card (optional, but recommended for best MIDI audio)

Headphones or speakers

Printer (optional)

Microsoft, MS-DOS, Windows and the Windows logo are either registered 
trademarks or trademarks of Microsoft Corporation. Apple is a registered trademark 
and QuickTime is a trademark of Apple Computer, Inc.

Installation for Windows 95 Users

If the Autoplay feature of Windows 95 is enabled on your computer, once you insert the 
1997 GME CD-ROM into your drive the installation program will automatically launch.  
Follow the on-screen instructions to continue the installation. If the Autoplay feature is 
disabled, you can begin the installation by going to Start, Run, and typing D:\
SETUP.EXE (Enter).

To actually run the GME97 after installation, do the following: Select Programs from the 
Start menu on the Taskbar. Then, choose Grolier Interactive followed by 1997 Grolier 
Multimedia Encyclopedia. Once the Grolier Multimedia Encyclopedia menu appears, 
click the Start button to launch the program.

Installation for Windows 3.1 or 3.11 Users

1. Select Run from the File menu.
2. Type D:\SETUP (where D is the CD-ROM drive letter) and press Enter.
3. Follow the on-screen instructions.
4. Double-click the 1997 Grolier Multimedia Encylcopedia icon to run the 1997 GME. 

It is unlikely, but in the event that the SETUP.EXE program fails to complete the 
installation, please see the MANINST.WRI file for instructions on how to setup the 1997 
GME without running the Setup program. If you would like to direct the installation 
specifically to your 16-bit system, go to File, Run, and type D:\GME\SETUP16.EXE 
(Enter).



Please note:  The setup program for QuickTime for Windows installs QuickTime files 
into your WINDOWS and WINDOWS\SYSTEM directories. Please see the 
MANINST.WRI 
file for instructions on running just the QuickTime installation.  

Troubleshooting

QuickTime for Windows 

The installation program for the 1997 GME will install a 32-bit version of QuickTime for
Windows for Windows 95; 16-bit for Windows 3.1. You should choose to install 
QuickTime and also Delete other versions of QuickTime if prompted to during the 
installation. Other applications you install after the 1997 GME (such as Grolier 
Interactive's How Would You Survive?) may install a 16-bit version of QuickTime for 
Windows which is designed for Windows 3.1 or 3.11. It is recommended that, if you have
How Would You Survive? or another program that uses a 16-bit version of QuickTime, 
you install this program before installing the GME97, which uses a later version of 
QuickTime. Installing an earlier (16-bit version) of QuickTime can cause a degradation of
multimedia performance on your system. To correct this condition, simply re-install the 
32-bit version of QuickTime for Windows 2.1.1.  The steps are as follows:

1. Put the 1997 GME CD-ROM in your CD-ROM drive.
2. If Autoplay is enabled on your computer, a window will appear asking you to 
   "Run" or "Cancel". Select "Cancel". (If this window does not appear, simply 
   skip to step #3.)

         3. Run the file QTW32.EXE, located in the \WIN95\QTW32 directory of the 
             CD-ROM drive. (Hint: Use the Windows Explorer to locate this file, and 
             double-click on it).

QuickTime Control Panel

Windows 3.1, 3.11 and Windows 95 users:
If you have installed the 16-bit version of QuickTime for Windows, you will see an icon 
in your Control Panel called QuickTime. If you have installed the 32-bit version of 
QuickTime for Windows, you will see an icon in your Control Panel called QuickTime 
32. Modifying the QuickTime Control Panel settings has corrected a wide variety of 
errors including the following:

* Invalid Page Fault Errors during Video playback
* Lockups while playing Videos
* Video and Sound Playback Problems

You can access the QuickTime Control Panel in Windows 3.1 or 3.11 by going to the 
Main Program Group and opening Control Panels.  In Windows 95, the QuickTime 



Control Panel can be accessed by clicking Start, Settings, and opening Control Panels.

Once you have double-clicked the QuickTime Control Panel icon and it opens, click the 
More button, located at the bottom of the QuickTime Control Panel. Click the Video tab 
at the top of this window and try modifying the Draw Method which is listed under 
Optimization. The most commonly used setting in Draw Method is Video Driver. If you 
own a Trident video card, we recommend using the BMP or Windows Bitmap. After 
selecting any Draw Method, click the Apply button and say Yes to the changes you made.
You do not need to restart Windows after adjusting the QuickTime Control Panel.

Multimedia Playback Problems:

In some cases with GME97, the QuickTime Calibration does not seem to work correctly 
on some systems. In these cases, the result has sometimes been extremely fast, distorted 
sound playback, particularly toward the end of QuickTime movies. Try modifying the 
QuickTime Control Panel settings as outlined in the QuickTime Control Panel section of 
this README.WRI  file to correct this problem with the sound playback.

Viewing Pictures and Movies
When opening pictures and viewing some movies, an Enlarge button may appear below 
the viewing box. The Enlarge button should be clicked to increase the size and the clarity 
of the image you are attempting to view.

Cannot Read From Drive D Errors and Lockups

Cannot Read from Drive messages or unexplained lockups can often be corrected by 
cleaning the bottom (unprinted side of the CD-ROM) with a soft, dry cloth from the 
center to the outside edge in a straight line. Fingerprints or smudges often cause these 
types of errors. If you have a CD with visible scratches, you may need to contact us at 
Technical Support at (800) 356-5590 about obtaining a replacement CD.  

Older versions of video and/or CD-ROM device drivers have also been known to cause 
these types of error messages. If you have not updated either your video or CD-ROM 
device drivers, and experience problems such as this, you may need to contact the 
manufacturer of your video card or CD-ROM drive to obtain these drivers.

Known Issues:

Font Sizes and Menu Tabs

Large Fonts at screen resolutions of 800 x 600 and above: If you are running the 1997 
GME on a system set to display Large Fonts, the text of tabs atop the content region of 
the application may appear truncated. To resolve this condition, change your display to a 
Small Font version of your video driver. This condition applies to both Windows 3.1, 3.11
and Windows 95.



Installation/Uninstallation of the GME97

The 16-bit installation places an uninstall icon in the GME97 program group which can 
be double-clicked to begin uninstalling the program. Windows 95 users should use the 
Add/Remove feature in the Control Panel. Navigate here: Start Menu / Settings / Control 
Panels / Add/Remove Programs icon. Then, select 1997 Grolier Multimedia 
Encyclopedia and click the Add/Remove button.

In some cases, running the uninstallation has not removed all files associated with the 
GME97, even if it appears to run successfully. This may occur because of unrelated 
changes to your system that have occured since you installed the GME. The 
uninstallation procedure will not remove entries from the Windows 95 Start menu and 
may leave behind some of the following files: col_file.map, compudir.gid,  gme97g$Q, 
gme0.col, gme1.col, pfar.bmp, and tinyansi.fon within the GME97 directory structure. 
The files that are left behind after uninstallation can vary, but these should be deleted 
manually if the uninstall routine does not remove them.

CD-ROM Device Drivers

These instructions apply to Windows 95 users:

Some CD-ROM drives may require that Microsoft CD-ROM Extensions (MSCDEX) be 
loaded in their CD-ROM device driver line because their drivers are 16-bit versions 
instead of the 32-bit versions normally used in Windows 95. Workarounds for problems 
with 16-bit versions of CD-ROM drivers include the following options: 1) installing the 
16-bit version of the GME97 by going to Start, Run, and typing D:\GME\SETUP16.EXE 
(Enter), 2) doing an Optimal installation of the 32-bit version of the GME97. The 32-bit 
version can be installed by going to Start, Run, and typing D:\WIN95\SETUP32.EXE 
(Enter). It is also recommended that the user update the CD-ROM drivers to the 32-bit 
versions of the drivers to be more compatible in the Windows 95 environment.

Video Driver Issues

a) ATI Mach 64 Video Card

Users of this video card may encounter problems with QuickTime. This can often be 
resolved by adding a line to the [MACX] section of  your SYSTEM.INI file. The line you
add to the [MACX] section should read:

DeviceBitmap=OFF

If this line is already there, please be sure there is no "s" at the end of Bitmap.

b) Trident and Headland Technology video cards

Modify the QuickTime Control Panel and select the draw method listed as BMP or 



Windows Bitmap.  Please see above for instructions on how to do this.  

c) Diamond Stealth 64 Card

Modify the [STLTH64] section of your SYSTEM.INI file.  The line you add to the 
[STLTH64] section should read:    

DeviceBitmaps=0

General Issues

If errors occur when running the 1997 GME, you should try the following things:

1. Make sure the correct CD-ROM is in the CD-ROM drive and that the drive is turned 
on. You cannot use the 1997 GME unless the CD-ROM is in the CD-ROM drive.

2. Verify that your equipment meets or exceeds the System Requirements (above).
3. Ensure that you are not running any other applications in the background.
4. Try restarting your computer.
5. Reinstall the product after first uninstalling the program from the system. (Note: in 
Windows 95, uninstall the program using the Add/Remove feature in the Control Panel. 
The 16-bit version of the GME97 places an uninstall icon within the GME97 program 
group in Windows 3.1 or 3.11).
6. Try using a different video display resolution. For example, if you are running 
Windows in 800x600, try 640x480. If your video card allows a choice of  "large font" or 
"small font", choose "small font".
7. Try using a lower number of colors for your video display. For example, if you are 
running Windows in millions or thousands of colors, try 256 colors. 256 colors is the 
minimum number of colors required for the 1997 GME.
8. Try to obtain the most recent drivers for your video card, sound card and CD-ROM 
drive. Newer drivers can have a profound effect on playback. At the end of this file, there 
is a list of contacts for video drivers.

Minimizing the GME97 Window

If the 1997 Grolier Encyclopedia program group window is maximized every time you 
start Windows (version 3.1 or 3.11), but you would like the program group to open 
minimized as an icon, follow the steps below:

1. Minimize the 1997 Grolier Encyclopedia Window group:
a.  Click the "down arrow" in the upper right hand corner of the window.

          or
           b.  Click on the "minus" sign in the upper left hand corner of the window then 
                  click Minimize or Close.                                                                               

2. Choose Save Settings on Exit from the Options menu in Program Manager.
3. Exit Windows.

     4. When you re-start Windows, the 1997 Grolier Encyclopedia group will be 



          minimized.

Sound Playback 

The 1997 Grolier Multimedia Encyclopedia contains both digital audio .wav and MIDI 
(Musical Instrument Digital Interface) format audio files. MIDI sound files are labeled as 
such in the caption. If your sound card does not have full wave-table MIDI capability, 
you will be able to play MIDI files, but the quality of sound will not be as high as it 
would be with full wave-table MIDI capability.

If you are not getting any sound in the 1997 GME, please check to be sure that your 
sound card is set up properly in Windows. Check to make sure your speakers are 
plugged in and all connections are proper as well. To check your Windows 3.1 or 3.11 
sound setup do the following:

1. Open the Main program group from Program Manager.
2. Double-click the Control Panel icon.
3. Double-click the Sound icon.
4. On the right side of the Sound window, you will see a list of files with the 
extension .WAV.
5. To test your sound card, click on any one of these files and then click Test.

*Windows 95 users, please see instructions below.

If you don't hear any sound or if these files are "grayed out", then your sound card is not 
working properly in Windows. Consult the sound card manual or manufacturer for 
information on how to set up the sound card properly in Windows.

*Windows 95 users
1. Go to Start then to Settings then to Control Panel.
2. Double-click on the Sounds icon.
3. Click on any of the events listed that have a speaker next to them.
4. To test your sound card, click on the play button (arrow pointing to right) under 
Preview.

If you don't hear any sound then your sound card is not working properly in Windows.  
Consult the sound card manual or manufacturer for information on how to set up the 
sound card properly in Windows.

The Grolier BBS

General Information about the Grolier BBS

Contact Grolier by modem 24 hours a day! Grolier Interactive is offering a Bulletin 
Board Service (BBS) to better meet your technical support needs.



You can use the BBS to send our Technical Support team messages concerning any 
problems you encounter. In most cases, you will receive a response to your question 
within one working day. To read our response to you, simply call the BBS the next day.  
If we have responded, you will automatically be notified at the time you connect.

Please remember the ID and PASSWORD you use when you leave us your message. In 
order to receive your reply, you will have to log-on using the same ID and PASSWORD.

What You Need To Know to Connect

Our BBS number is 203-797-6872. You will need a 2400bps or higher speed modem to 
access the board.  Set your communications software to DATA BITS=8, PARITY=N, 
STOP BITS=1.

Don't forget that Windows 3.1 comes with a communications program called Terminal 
that you can use to log on to the Grolier BBS. The Windows 95 communications program
is called HyperTerminal and is located in the Accessories group.

Grolier on the Internet

Grolier's World Wide Web site offers visitors in-depth information about Grolier 
products.  The Internet address is http://www.grolier.com.

To send a question to Technical Support, the email address is techsup@grolier.com

Contact List for Video Driver Manufacturers
(Updated 07/22/96)

ATI Technologies        
voice: 905-882-2626               

Cirrus Logic
voice: 800-764-7200
bbs: 510-440-9080
internet: ftp.cirrus.com

Compaq Computer Corp.
voice: 800-652-6672
bbs: 713-378-1418
internet: www.compaq.com

Diamond Multimedia
voice: 408-325-7100
bbs: 408-325-7175                                                        
internet: www.diamondmm.com



Hercules Computer Technology        
voice: 510-623-6050             
bbs: 510-623-7449
internet: www.hercules.com

Number Nine Corp.
voice: 617-674-8595
bbs: 617-862-7502             
internet: www.nine.com                                                                                

Packard Bell
voice: 801-579-0161
bbs: 801-250-1600
internet: www.packardbell.com

Trident
voice: 415-691-9211
bbs: 415-691-1016

TSeng Labs
voice: 215-968-0502
bbs: 215-579-7536


